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1 ecoinvent v.3.3 - What’s new?

The ecoinvent v.3.3 database was released on the 15" August 2016 and included important

updates and additions, such as:

World Food LCA Database (WFLDB): several hundreds of new agricultural dataset were
added, covering fields such as vegetables, fruits, cereal and grain products, tee, coffee
and sugar and confectionery. For many products, production in different countries and
using different technologies are included, as well as distinction between fresh and
processing grade.

Prices for all products: ecoinvent v.3.3 includes price data for all the products, except for
waste materials and their disposal. These prices can be used with the new Life Cycle
Costing features of openLCA 1.5 (check section 2.2 for further details).

Improved markets and supply chains: some sectors were updated to include more
specific, local data. For instance, waste treatment activities in Europe and Switzerland.
PDF documentation of every dataset is available in ecoinvent v.3.3. For further details on

how to access them from openLCA, check section 2.3.

For more information about the content and methodology of ecoinvent v.3.3 database, please

check the report of changes or the ecoinvent website.

2 ecoinvent v.3.3 in openLCA

As in previous ecoinvent 3 versions, six data packs generated by the ecoinvent Centre from the

undefined ecoinvent database are provided containing the three different system models, all as

unit and aggregated processes:

Allocation, allocation at the point of substitution' (unit and system? processes)
Allocation, cut-off by classification (unit and system processes)

Consequential long-term (unit and system processes)

In addition, access to older versions of the ecoinvent database is also provided when purchasing

ecoinvent v.3.3 in openLCA Nexus.

'In ecoinvent 3.1 and previous versions, this system model was named “allocation, default”
*Named “LCI” in the data files


http://www.quantis-intl.com/microsites/wfldb/
http://www.ecoinvent.org/files/change_report_v3_3_final.pdf
http://www.ecoinvent.org/database/ecoinvent-33/ecoinvent-33.html
https://nexus.openlca.org/database/ecoinvent

All the different data packs can be used as independent databases in openLCA or combined
together, if necessary®. Moreover, in order to be able to reproduce the LCIA results reported by
the ecoinvent Centre, a pack with the LCIA methods as implemented by them is also available

for download in openLCA Nexus.

Ecoinvent v.3.3 is implemented for openLCA 1.5, the new and even more powerful version of the
LCA software. Consequently, some differences in the database may be observed due to new
developments in the software. For instance, openLCA 1.5 allows the usage of the same flow
several times in a process, with different providers. Therefore, the number of product flows was
considerably reduced in the openLCA version of ecoinvent v.3.3 in comparison with ecoinvent
v.3.2, simplifying the modelling of new datasets. Moreover, openLCA 1.5 includes new features
for Life Cycle Costing which, in addition to the new price data of products included in ecoinvent
v.3.3, allows you to calculate the net added value of your ecoinvent product systems.
Furthermore, openLCA 1.5 includes the possibility of accessing internet sources directly from the
source editor. Consequently, the new PDF documentation files, as well as the UPR, LCl and LCIA
web pages of the ecoinvent website can be easily accessed for all processes. And, what’s more,
comments for all the exchanges, if included in the original EcoSpold2files, are now visible in the

Inputs/Outputs tab of the processes.

In addition, other improvements carried out for previous ecoinvent versions during their
implementation in openLCA are also included in ecoinvent v.3.3: update of the names of the
activities to simplify the modelling of new processes and results analysis, update of identifiers
of the activities to allow the combination of different system models and process types in a
single openLCA database, addition of the values of missing text variables in the metadata fields,

refactoring of categories in the allocation models, etc.

Finally, a script for updating your own processes and product systems which include ecoinvent
v.3.2 products is provided to facilitate the conversion of your models from ecoinvent v.3.2 to
ecoinvent v.3.3. Further details about the implementation work done and the functionalities of

the new ecoinvent v.3.3 in openLCA are explained in the next sections of this report.

31t is recommended to always import the data pack of smaller size into the bigger one to reduce the

time of the import (e.g. unit process data files into LCI data files).


http://www.openlca.org/download_page

2.1 Product flows with multiple providers

In older versions of openLCA (i.e. 1.5.0 beta 1 and previous), a product flow could not be used
multiple times in the same process with different providers. As this is the case in most of the
activities of ecoinvent 3 (e.g. several electricity flows provided by different electricity markets),
it was not possible to have a single product flow produced by multiple activities in the ecoinvent
database in openLCA. Consequently, there were several product flows with the same name,
location and category but produced by different processes. For instance, “electricity, high
voltage” was the reference product of 1,702 processes in the ecoinvent v.3.2, allocation at the

point of substitution system model, and, therefore, it was included as 1,702 different flows in

openLCA* (Figure 1).
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Figure 1: Example of ecoinvent v.3.2 different products with the same name but produced by different processes in

« electricity, high voltage | electricity production,
» electricity, high voltage | electricity production,
» electricity, high voltage | electricity production,
« electricity, high voltage | electricity production,
» electricity, high voltage | electricity production,
» electricity, high voltage | electricity production,
«» electricity, high voltage | electricity production,
«» electricity, high voltage | electricity production,
» electricity, high voltage | electricity production,
» electricity, high voltage | electricity production,
« electricity, high voltage | electricity production,
Fe

electricity, high voltage | electricity production,
electricity, high voltage | electricity production,

openlCA 1.5

However, in ecoinvent 3.3 a unique flow “electricity, high voltage” is included (Figure 2).

nuclear, pressure water reactor - WECC, US only
nuclear, pressure water reactor - ZA

peat - EE

peat - Fl

peat - |E

peat - RoW

peat - RU

peat - SE

wind, <1MW turbine,
<TMW turbine,
<1MW turbine,
<TMW turbine,
<1TMW turbine,

onshore - ASCC
wind, onshore - AT
wind, onshore - AU
wind, onshore - BE

wind, onshore - BG

v B 3510:Electric power generation, transmission and distribution

Figure 2: Example of ecoinvent v.3.3 unique products, which can be produced by multiple processes, in openLCA 1.5

™ 3510a: Electric power generation based on liquid fuels

8 3510b: Electric power generation, photovoltaic

k= blast furnace gas

Fs coal gas

Fe electricity, high voltage

k= electricity, high voltage, aluminium indust
Fs electricity, high voltage, for internal use in
k= electricity, high voltage, label-certified

k= electricity, low voltage

ks electricity, low voltage, label-certified

Fs electricity, medium voltage

ry

coal mining

ks electricity, medium voltage, aluminium industry

F= electricity, medium voltage, label-certified

F= heat, district or industrial, other than natural gas

F= natural gas, burned in gas motor, for stor.

#In order to facilitate the selection of products, the name of the provider was added in the product

name in the openLCA version of ecoinvent v.3.2 (i.e. “product name | provider name”).
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How is this affecting the modelling of your own processes using ecoinvent v.3.3 products? First
of all, the selection of the product to be included in your process will be easier due to the
reduction in number of flows. Moreover, you will have more flexibility modelling your processes
as different providers can be selected for the same exchange, without needing to change the
flow too. However, it should be taken into account that as multiple providers might be available
per flow, it is recommended to set always the desired “Default provider” in the inputs table
before creating the product system (Figure 3). That way, when selecting the option “Add
connected processes” during the creation of the product system, the supply chain wanted will

be added. Otherwise, openLCA will select randomly one of the possible providers for that flow.

~ Inputs
Flow Category Amount Unit Costs Uncertainty  Provider
Fe electricity, high voltage ~ 351:Electric power g... 1.00000 = MJ none P market for electricity, high ...
Ferice 011:Growing of non... 1.00000 = kg none rice production - CN v

market for rice - GLO

rice production - IN
rice production - RoW
rice production - US

Figure 3: Example of selection of default provider for an ecoinvent v.3.3 product in openLCA 1.5

ecoinvent v.3.3 processes have the default provider always defined for all input products, thus,
the connections of the correspondent supply chains will be properly created automatically as in

previous versions of the ecoinvent database in openLCA.

2.2 Addition and extension of price data

The new ecoinvent 3.3 database contains price data for all products except waste materials and
their disposal. In openLCA 1.5 this information is included in the “Costs” and “Costs/Revenues”
columns of the inputs and outputs of the process, respectively. However, the original ecoSpold2
files provided by ecoinvent did not contain the price information for all the intermediate
exchanges using those products, but in many cases only for the quantitative references of the
processes (Figure 4). Thus, the price information was extended during the implementation in
openlLCA so that all exchanges of products with price data had the correspondent cost/revenue

specified (Figure 5).

It should be noted that the prices provided by ecoinvent are global prices and technology
independent. Thus, the same price is considered for e.g. “rice production” in US and India; or for

“electricity, high voltage” produced by hydropower plants, oil or hard coal.



~ Inputs

Flow Category Unit Costs Uncertainty Provider
Fstransport, freight, inland water... 502:Inland water trans... ™ t*km lognormal: ... P market fo...
Fztransport, freight, lorry, unspe... 492:Other land transp.. ™ t*km lognormal: ... P market fo...
Fztransport, freight train 491:Transport via railw... ™ t*km lognormal: ... P market gr...
Fztransport, freight, sea, transoc... 501:Sea and coastal w... ™ t*km lognormal: ... P market fo...
~ Outputs

Flow Category Unit Costs/Reven... Uncertainty Avoided pro...
EF»rice 011:Growing of non-p... ™ kg 0.37000 EUR  none

Figure 4: Excerpt of “market for rice | rice — GLO” after importing the ecoSpold2 files in openLCA 1.5

~ Inputs

Flow Category Unit Costs

Fetransport, freight, sea, transoc... 501:Sea and coastal w... ™ t*km 0.00075 EUR

fetransport, freight, lorry, unspe... 492:Other land transp... ™ t*km 0.00220 EUR

Fetransport, freight, inland water... 502:Inland water trans... ™ t*km 0.00089 EUR

Fetransport, freight train 491:Transport via railw... ™ t*km (0.026*0.2184)*gd_price_product EUR
~ Outputs

Flow Category Unit Costs/Revenues

Ferice __011:Growing of non-p.. @ kg 0.37000 EUR

Figure 5: Excerpt of “market for rice | rice — GLO” after adding the missing costs in openLCA 1.5

Moreover, there were some inconsistencies between system models in ecoinvent, having some
products the price specified in e.g. the cut-off model but not in APOS (e.g. “gypsum fibreboard”
produced by “gypsum fibreboard production” in Switzerland). During the implementation in
openLCA, those missing prices were added, being equal to the ones included in the other system
model(s) for the same product and process. The global parameter “ei_price_product” was added
to those costs/revenues with a default value of 1, in order to allow the user to decide whether
they want to keep the original ecoinvent value for that system model (i.e. ei_price_product = 0),

or the value as in the other system model(s) (i.e. ei_price_product =1).

In addition, there were some products or co-products of waste treatments (i.e. positive reference
product), which did not have a price specified by ecoinvent and that were considered that they
should have a cost/revenue specified (e.g. “transport, freight train” from “market group for
transport, freight train” — Global). The prices used for them, equal to the prices of the same
product in other processes of the database, are modified by the global parameter
“gd_price_product”, with default value 1 (Figure 5). If you want to have no price for them like in

the original ecoinvent files, you can change the parameter value to o.



Moreover, there were exchanges which did not have a price specified by ecoinvent for being
wastes (i.e. negative reference product), and that were considered that they should have a
cost/revenue specified. The prices used for them, equal to the prices of the same product in
other processes of the database, are modified by the global parameter “gd_price_waste” with
value o.5 (i.e. half the price of the normal product), considering that the reference product of a
waste treatment process might have a lower price in reality than the same flow produced by a
production process. However, you can modify this value to o if you prefer to consider no price

for them like ecoinvent, or also 1 if you do not want to distinguish wastes from other products.

Table 1. Global parameters used by products without price in the original ecoinvent v.3.3 files, for which a price was added

by GreenDelta during the implementation in openL.CA

Global L Default
Description
parameter value
o Used by products which have a price specified for that specific 1
ei_price_product o
provider in other system model
Used by products and co-products of waste treatments (i.e. positive 1
gd_price_product reference product) without price specified for that specific provider
but yes for other processes
Used by wastes (i.e. negative reference product) without price 0.5

gd_price_waste . o
specified for that specific waste treatment but yes for other processes

There were six flows without a corresponding product in the database for which it was
considered that a price was needed. These are listed in Table 2. Those prices are also multiplied

by the correspondent global parameter from Table 1.

Table 2. New prices added by GreenDelta in ecoinvent v.3.3

Intermediate

Price Unit Source
exchange
scrap lead acid
0.121 €/kg http://www.recycle.net/battery/class_b1/xvo20100.html
battery
scrap aluminium 0161 €/kg http://metrometalsrecycling.com/scrap-metal-prices/
scrap copper 0.402  €/kg http://metrometalsrecycling.com/scrap-metal-prices/

) https://www.alibaba.com/product-detail/tin-plate-scrap-tin-
scrap tin sheet o710  €/kg
sheet 50030419087.html?spm=a2700.7724857.0.0.JX5Kxn

scrap steel o.012  €/kg https://rockawayrecycling.com/metal/steel/
natural gas,
ted 0.200 €/m? Based on other natural gas prices of ecoinvent v.3.3
vente



The rest of waste products without price specified by ecoinvent remain without any

cost/revenue defined in openLCA.

Thanks to the new life cycle costing features of openLCA 1.5, all this information can now be used

to calculate the net added value of product systems using ecoinvent data. For further details on

IU

how to perform such calculations, please check the manual “Life Cycle Costing in openLCA”

available in the openLCA website.

2.3 Additional documentation for processes and exchanges
All the ecoinvent v.3.3 processes have four new sources in the “Modelling and validation” tab

(Figure 6):

- PDF documentation: a report provided by ecoinvent specific of each dataset.
- UPR link: the link to the unit process dataset in the ecoinvent website.
- LCllink: the link to the LCl dataset of that process in the ecoinvent website.

- LCIAlink: the link the LCIA dataset of that process in the ecoinvent website.

~ Sources

I PDF link: grape production | grape | APOS - GLO
JUPR link: grape production | grape | APOS - GLO
ILCI link: grape production | grape | APOS - GLO

ILCIA link: grape production | grape | APOS - GLO

General information Inputs/Outputs  Administrative information Modeling and validation| Parameters Allocation Social aspects

Figure 6: New sources included in ecoinvent v.3.3 for the process “grape production | grape | APOS — GLO” in openLCA 1.5

All those sources are stored under “Background data”-> “Sources” and the corresponding

category, which equals the process category (Figure 7).

v # Background data
= Flow properties
= Unit groups
= Currencies
v B Sources

= LCIA links

= LCl links

™ PDF Documentation links
v 8 UPR links

v B A:Agriculture, forestry and fishing

v @ 01:Crop and animal production, hunting and related service activities
v ® 011:Growing of non-perennial crops
v ® 0111:Growing of cereals (except rice), leguminous crops and oil seeds
1 UPR link: barley grain, feed production, organic | barley grain, feed, organic | APOS - CH
UPR link: barley grain, feed production, organic | barley grain, feed, organic | APOS - RoW

Figure 7: Example of new ecoinvent v.3.3 sources in the navigation pane of openLCA 1.5


http://www.openlca.org/documents/14826/87f1931b-9553-4eb8-a789-fe7cb6f2b829

The source editor was extended in openLCA 1.5 in order to be able to access internet links directly
from the software. Now you can select the button “Open” in right of the URL field, and a new

tab in your browser will be opened with the corresponding ecoinvent information (Figure 8).

Source: PDF link: market for textile, knit cotton | textile, knit cotton | APOS - GLO

= General information
Name PDF link: market for textile, knit cotton | textile, knit cotton | APOS - GLO

Description | Link to the documentation of the activity: “market for textile, knit cotton™ - GLO, with reference product: “textile, knit cotton”, of the system model: “Allocation,
APOS".

Category ™ pDF Documentation links > ¢ Manufacturing > 13:Manufacture of textiles > 139:Manufacture of other textiles > 1391:Manufacture of knitted and crocheted fabrics
Version 00.00.000
uuiD f3742628-262e-3541-82c0-7315c8e79494

Last change

- Additional information

URL https://v33.ecoquery.ecoinvent.org/Details/PDF/B461E679-C0O3E-4E69-8728-4839266738E5/06590A66-662A-4885-8494-AD0OCF410F956
Text reference
Year

File Browse

Figure 8: ecoinvent v.3.3 source “PDF link: market for textile, knit cotton | textile, knit cotton | APOS — GLO” in openLCA

1.5

Please, take into account that you will need to be logged to the ecoinvent website to access the
link. If you weren’t logged in, the ecoinvent login page will be shown when clicking “Open” in
openLCA. After introducing your login details, you will be redirected to the link included in the
source of openLCA. For the PDF documentation, you will be asked if you want to download or

open the file.

Go to Undefined UPR

Dataset Information (UPR)

barley grain, feed production, organic, CH, (Author: Sebastiano Meier inactive)

Link to: Exchanges

Activity

Activity Mame barley grain, feed production, organic
Type UnitProcess

Special Type OrdinaryTransformingActivity
Inheritance Depth LinkedDataset

e oa . o - - a v W rroae

Figure 9: ecoinvent v.3.3 source “UPR link: barley grain, feed production, organic | barley grain, feed production, organic

| APOS — CH” in openLCA 1.5
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In addition, a new field “Description” has been added in the Inputs/Outputs tab of the process
editor in openLCA 1.5, containing additional information about the exchanges as provided in the

original ecoSpold2 files of ecoinvent (Figure 10).

~ Inputs O %
Flow Category Am.. Unit Co... Uncertainty Provider Pedigree u... Description
feWater, cooling, unspecifie... Resource/in water 0.05.. ™ m3 lognormal... (3:5:5;1;3) Literature Value Edit
Fecleft timber, measured as... 022:Logging/0220:.. 2.40.. ™ kg 0.1.. lognormal.. P market.. (3;4,53:3) kg dry mass, including bark; 0.0051:
Fs electricity, medium voltage 351:Electric power ... 0.07.. ™ kWh (0... lognormal.. P market.. (3;4;53;1) EcoSpold01lLocation=UCTE
Fzheat, central or small-scal... 382:Waste treatme... 0.72.. ™ M) (0... lognormal.. P market.. (3;4;53;1) EcoSpoldO1Location=CH
Fz cleft timber, measured as... 022:Logging/0220:... 0.10.. ™ kg 0.0.. lognormal.. P market.. (3;4:5:3;3) kg dry mass, including bark; 0.0051:
Fz cleft timber, measured as... 022:Logging/0220:... 0.01.. ™ kg 0.0.. lognormal.. P market.. (3;4:53;3) kg dry mass, including bark; 0.0051:

Figure 10: Inputs from “charcoal production | charcoal | cut-off, U” in openLCA 1.5

For long descriptions, you can read and edit their content easily by clicking on the “Edit” button

and a pop-up window will be shown (Figure ).

L4 Comment X

. h(g dry mass, including bark;
0.005128=original v2.2 value in m3

Cancel

Figure 11: Pop-up window with the exchange description in openLCA 1.5

Moreover, some metadata fields had missing text variables or incorrect definition of the content
in the original ecoSpoldz2 files, which made that the data shown after the import in openLCA
was not complete. This was corrected also during the implementation and now full comments,

technology descriptions, etc. are available.

2.4 Renaming of activities

Some openlLCA users pointed out for previous ecoinvent 3 versions that the fact that several
processes existed with the same name, location and category but producing different reference
products was a limitation for a fast modelling and results analysis. This issue was caused
because when applying the different system models in ecoinvent 3, a single undefined activity
is split into several new activities producing each of the co-products. However, the name of the

original activity is maintained in all of them.

n


http://www.ecoinvent.org/database/ecoinvent-33/known-data-issues-ecoinvent-33/known-data-issues-ecoinvent-33.html

4 [Pl D144:Raising of sheep and goats

Figure 12:

V.1.4.2

B
B
B
B
B
B
B

market for sheep fleece in the grease, alloc. default, S - GLO

market for sheep for slaughtering, live weight, alloc. default, 5 - GLO

sheep for slaughtering, live weight to generic market for red meat, live weight, alloc. default, 5 - GLO
sheep production, for meat, alloc. default, S - RoW

sheep production, for meat, alloc. default, S - RoW

sheep production, for meat, alloc. default, S - US

sheep production, for meat, alloc. default, 5 - US

Example of ecoinvent v.3.1, allocation default activities with the same name, location and category in openLCA

In the new ecoinvent v.3.3 databases, as in v.3.2, the names of the processes have been extended

to allow a straightforward identification of each activity without the need of opening the

correspondent dataset. The name of the activities in openLCA follows this schema:

Activity name | Reference product name | System model, Process type

The nomenclature used for the system model information is:

APOS: Allocation, allocation at the point of substitution

conseq. long-term: consequential long-term

cut-off: Allocation, cut-off by classification

The process types are indicated with “U” for unit processes (i.e. non-aggregated datasets) or “S”

for system processes (i.e. LCI results).

v B 0144:Raising of sheep and goats

P

P
P
P
P
P
P
P
P
P
P

market for sheep fleece in the grease | sheep fleece in the grease | APOS, U - GLO

market for sheep for slaughtering, live weight | sheep for slaughtering, live weight | APOS, U - GLO

sheep for slaughtering, live weight to generic market for red meat, live weight | red meat, live weight | APOS, U - GLO

sheep production,
sheep production,
sheep production,
sheep production,
sheep production,
sheep production,
sheep production,
sheep production,

for meat | sheep fleece in the grease | APOS, U - RoW

for meat | sheep fleece in the grease | APOS, U - US

for meat | sheep for slaughtering, live weight | APOS, U - RoW
for meat | sheep for slaughtering, live weight | APOS, U - US
for wool | sheep fleece in the grease | APOS, U - RoW

for wool | sheep fleece in the grease | APOS, U - US

for wool | sheep for slaughtering, live weight | APOS, U - RoW
for wool | sheep for slaughtering, live weight | APOS, U - US

Figure 13: Example of ecoinvent v.3.3, allocation at the point of substitution activities in openLCA v.1.5

The information of the system model and the process type was added because users can

combine different data packs together in a single openLCA database (e.g. consequential long-

term unit and system processes; three system models together; etc.). More information is

provided in section 2.5.
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Note: In some cases, it was necessary to truncate the name of the reference product due to the

limitation of 255 characters per name.

Developer box 1: Rewriting activities to their original ecoinvent names

In case you were interested in using the original ecoinvent names, that is, without the additional
information described in the sections above, you can use the following Python script:

e Rewriting activities and intermediate exchanges to their original ecoinvent names:
import org.openlca.io.KeyGen as keygen

def change process name (process) :
old name = process.name
i = old name.find('|")
new_name = old name[0:i-1]
process.name = new_name
olca.updateProcess (process)

olca.eachProcess (change process name)

Note: This code will delete also the information regarding the system model and process type
(i.e. U, S). If you want to add later that information, you can use the following Python script:

¢ Adding system model and process type information to original ecoinvent activity names:

import org.openlca.io.KeyGen as keygen

# define the system model and process type here
system model = 'conseq. long-term'
process_type = 'U'

def change name (process) :
old name = process.name
new_name = '%s, %s, %s' % (old_name, system model, process_type)
process.name = new_name
olca.updateProcess (process)

olca.eachProcess (change name)

If you want to have the additional information in the description fields like in version 3.1, you
can use the next script to include the reference product name in the activity’s description.
e Add reference product information to the activity descriptions:

import org.openlca.io.KeyGen as keygen

def extend descriptions (process) :

process_name = process.name

process_location_code=process.location.code

process_description = process.description

new_process_description = 'Reference product: "%s - %s". %s' %(flow_name,
flow_location_code, process_description)

process.description = new_process_description

olca.updateProcess (process)

olca.eachProcess (extend descriptions)

13



2.5 Update of UUIDs

openLCA’s versions of ecoinvent v.3.1 and v.3.2 included already the possibility of combining
different system models and process types within a single openLCA database, as explained in
this video. This feature has been maintained in ecoinvent v.3.3: the Universally Unique Identifier
(UUID) of the activities in openLCA were changed to be different between system models and
process types. This is necessary because if a process with the same identifier exists already in
the database, it will not be added during the import. Thus, for being able to combine system

models in a single openLCA database, the process UUIDs are now unique between data packs.
However, there are two differences with ecoinvent v.3.2:

- The UUID of equal product flows was already identical between system models due to
the modelling improvement of openLCA 1.5 which allows the usage of the same flow
with different providers in a process (see section 2.1 for further details). Thus, no changes
in the product flows UUIDs were needed after importing ecoinvent’s ecoSpoldz files.

- Duetothe same change in the software, it was not possible to update the UUIDs of the
products with those from ecoinvent v.3.2 as it was done to facilitate the conversion
between ecoinvent v.3.1 and v.3.2 (i.e. multiple product flows in ecoinvent v.3.2 refer to
the same product flow in ecoinvent v.3.3). Consequently, in other to simplify the
conversion from v.3.2 to v.3.3, a script and a mapping file are provided instead. Section 3

contains explanations on how to perform the conversion.

2.6 Refactoring of categories
The activities and product flows are categorized following the correspondent sectors IDs as
included in ecoinvent’s metadata, which allows a very easy navigation through the database, as

shown in Figure 14.

Moreover, in the allocation system models, there were activities without any category stated.
Most of them were electricity activities, which are now placed in the general category
“3510:Electric power generation, transmission and distribution” as their reference product. In
the cut-off system model, there were also activities without category defined as “Recycled
Content cut-off” processes. For those, a new category “Recycled content cut-off” was created.
Their correspondent products were placed in the category of the other processes producing

them, except from “log, energy wood, split, measured as solid wood under bark” which was only
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produced by the recycled content cut-off process and it was placed in a new flow category

“Recycled content cut-off”.

v B Processes
v W A:Agriculture, forestry and fishing
= 01:Crop and animal production, hunting and related service activities
v W 02:Forestry and logging
v B 021:Silviculture and other forestry activities
® 0210:Silviculture and other forestry activities
= 022:Logging
™ 023:Gathering of non-wood forest products
= B:Mining and quarrying
= C:Manufacturing
8 D:Electricity, gas, steam and air conditioning supply
= E:Water supply; sewerage, waste management and remediation activities
® F:Construction
® G:Wholesale and retail trade; repair of motor vehicles and motorcycles
= H:Transportation and storage
™ J:Information and communication
W | :Real estate activities
= M:Professional, scientific and technical activities
= N:Administrative and support service activities
= Recycled Content cut-off
m S:Other service activities

Figure 14: Overview of some process categories in ecoinvent v.3.3, allocation, cut-off by classification in openLCA v.1.5

2.7 Mapping of elementary flows

As with almost all the databases provided in openLCA Nexus, the elementary flows used in the
ecoinvent v.3.3 database were mapped to openLCA reference data. This allows more consistency
in the elementary flows when combining different inventory databases from Nexus, as well as

the possibility of using the openLCA LCIA methods pack.

A new elementary flow (i.e. “Acrinathrin” — soil/agricultural) was added to the openLCA
reference list because not match could be found in the existing list. However, it should be noted

that the openLCA LCIA methods pack has not yet been updated to include it.

If you are interested in having the ecoinvent v.3.3 data pack provided in openLCA Nexus without

openLCA reference data, please contact us.

2.8 ecoinvent LCIA methods
The ecoinvent LCIA methods packs provided in openLCA Nexus are intended to be used ONLY
with the correspondent ecoinvent database in order to reproduce the LCIA results reported by

the ecoinvent Centre. They should not be used with other databases available in Nexus as not
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all the openLCA elementary flows are characterised in them, only those used by the ecoinvent

databases.

In the pack for version 3.3, the ILCD recommended methods were included as well as updates of
other methods. Documenation of the LCIA implementation in ecoinvent v.3.3 is included in this

file provided by the ecoinvent Centre in their website°.

For additional information regarding the implementation of LCIA methods by the ecoinvent

Centre, please check:

Hischier R., Weidema B., Althaus H.-J., Bauer C., Doka G., Dones R., Frischknecht R., Hellweg S.,
Humbert S., Jungbluth N., KélIner T., Loerincik Y., Margni M., and Nemecek T. (2010)

Implementation of Life Cycle Impact Assessment Methods. Final report ecoinvent v2.2 No. 3.

Swiss Centre for Life Cycle Inventories, Diibendorf, CH.

3 Converting own datasets from ecoinvent v.3.2 to ecoinvent v.3.3

As mentioned previously in this report, the ecoinvent v.3.3 identifiers could not be updated to
match with those in ecoinvent v.3.2 as multiple products from ecoinvent v.3.2 correspond to a
single ecoinvent v.3.3 flow (see section 2.1 for details). However, a Python script has been

created to facilitate the conversion between ecoinvent v.3.2 and v.3.3. The procedure would be:

1. Download the zip file “Convert own datasets from ecoinvent v.3.2 to ecoinvent v.3.3”
available in Nexus (i.e. ecoinvent v.2.2&v.3.3 - Database details > Additional
documentation).

2. Extract the content of the zip file.

3. Activate the openLCA database containing your own processes using ecoinvent v.3.2
products.

4. Open the Python file “Conversion of ecoinvent v.3.2 to v.3.3.py” with a text editor (e.g.
NotePad+), copy the content and paste it into the Python editor of openLCA (i.e.
Window -> Developer tools - Python).

> You will need to be logged in to the ecoinvent databases area of the ecoinvent website to be able to
download the file “ecoinvent 3.3_LCIA_implementation.7z”. Login information to the ecoinvent website
is provided after the ecoinvent license is granted in Nexus, except for the yearly licences.
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5. Update the directories in the Python script for the other files included in the zip (i.e.
“mapping_ei32_to_ei33.csv” and “categories_ei33.csv”). Please, note that the name of
the file must also be included.

6. Update the directory where you want to store the conversion reports. Please, note that
only the directory where you want to store the files should be written ending with “/”.
The names of the files generated will be report_conversion_other_processes.csv" (i.e.
for your own processes) and “report_conversion_ecoinvent 3 2 processes.csv”.

7. Run the Python script in openLCA (i.e. green arrow in tool bar).

8. Once the conversion is finished, you can export your processes, product systems and
projects using the JSON LD format (i.e. File->Import->JSON LD -> select the specific
datasets that you want to convert).

9. Download from openLCA Nexus the ecoinvent v.3.3 data pack you are interested in (e.g.
ecoinvent 3.3 — consequential long-term LCI) and import the file into openLCA.

10. Import the JSON LD exported in step 8 into the new ecoinvent 3.3 database (i.e.
File>Import->JSON LD import).

During the import, as the ecoinvent v.3.2 products and process UUIDs were previously modified
to the ecoinvent v.3.3 identifiers, those processes and flows existing in both versions will be

mapped to v.3.3. The correspondence file provided by the ecoinvent Centre was used for the

mapping. However, it should be noted that there are some activities/products that could not be
included in the automatic mapping during the import. Consequently, they will be imported to

the new database, and further conversion work would be needed. Those are:

- Activities/products replaced by more than 1 activity/product in ecoinvent v.3.3

- Activities/products which have been deleted in v.3.3

Moreover, there are some activities/products mapped differently depending on the system
model. Therefore, it is strongly recommended, if you have combined multiple ecoinvent v.3.2
system models or unit and LCI datasets into the openLCA database, to have all the default

providers set for the ecoinvent products used in your own processes.
If your database contains also product systems or projects, these will also be imported.

It is also possible to export your processes or product systems, for example, as ILCD format in

step 8 and import them into the new database. The flows and processes existing in both
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databases will be mapped to the ecoinvent v.3.2 datasets. However, due to limitations in the
format, the information regarding the default providers in the process datasets will be lost.
Moreover, if a product flow used in the process dataset is not included in v.3.2 or there is not a
direct match to the new product flows, there will not be a provider for that flow unless the

correspondent ecoinvent v.3.2 producing process is also included in the file imported.

If you were interested in GreenDelta carrying out the complete conversion of your datasets or

assist you with the conversion, please contact us.

4 Quality assurance

The inventory and impact assessment results calculated for product systems using unit process
datasets in openLCA were compared to the LCl and LCIA results published by the ecoinvent
Centre. As it can be observed in the example plotted in Figure 15, the LCl results obtained in
openLCA were almost equal® to the ecoinvent system processes, with the exception of the social
flows in the consequential model; however, as explained in section 5.1, ecoinvent recommends
to ignore those flows in the current database.
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Figure 15. Ratio unit process LCl results to LCI process for "market for waste plastic, consumer electronics | waste plastic,

consumer electronics | APOS - RoW", ecoinvent v.3.3, openLCA v.1.5 (i.e. ratio of 1 represents equal inventory values)

Note: If the amount of memory allocated to openLCA is too low, it might lead to errors during

the calculation due to the high amount of processes and links per product system. If that occurs,

® Slight differences might be caused by rounding during the calculation

GreenDeLTa 18


mailto:gd@greendelta.com

you can increase the memory usage in: File> Preferences—=> Configuration=> Maximum memory

usage.
5 Known issues, limitations

5.1 Database
e The input exchanges listed in Table 3 were deleted from the consequential long-term

system model following indications from the ecoinvent Centre.

Table 3. Deleted input exchanges in the consequential long-term system model

Intermediate exchange Activity Location Amount Unit
residual wood, dry market for residual wood, dry GLO 1 m?3
market for venting of nitrogen,
venting of nitrogen, liquid liauid GLO 1 kg
iqui

This was necessary due to an error in the original EcoSpold2 files, where the default
providers indicated for the exchanges were activities not producing those product flows.

This issue will be fixed by the ecoinvent Centre in next versions of the ecoinvent database.

e According to ecoinvent, the following social flows included in the consequential, long-term

”» “°

system model should be ignored: “residual hardwood, wet”, “residual softwood, wet”,
“residual wood, dry”, “venting of argon, crude, liquid” and “venting of nitrogen, liquid”. The
inventory results for these flows obtained using product systems with unit processes will

not match the LCl results provided by ecoinvent.

¢ No mathematical relations (i.e. parameters) are included in the openLCA data packs
because they refer to the undefined activities, that is before allocation, and may not be
reflecting the amounts in the dataset any more. If you are interested in checking them

anyway, you can review the EcoSpoldz files available in the ecoinvent website’.

Other known issues of the ecoinvent v.3.3 database are listed in the ecoinvent website.

7 Login information to the ecoinvent website is provided after the ecoinvent license is granted in Nexus,

except for the yearly licences.
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5.2 openlLCA

In many cases, there are different flow properties specified for the different exchanges which
are not flow specific, but exchange specific in the original ecoSpoldz files (e.g. carbon content,
water content, price, etc.). Currently, it is not possible to display in openLCA this information, so
it is recommended to the users interested in it to review the EcoSpold2 files available for

download in the ecoinvent website.

6 Summary

The ecoinvent v.3.3 in openLCA contains all the numerous updates and new data from the

ecoinvent Centre, as well as the following benefits:

- Extended cost/revenue data in the ecoinvent v.3.3 database that can be used with
the new Life Cycle Costing features of openLCA 1.5.

- Possibility of using the same flow with multiple providers in a process, which
simplifies the modelling of your own processes using ecoinvent products.

- Easy access from openLCA to the PDF reports and links to ecoinvent’s web pages of
the unit process dataset, LCl and LCIA results per process.

- Possibility of combining different system models and process types in a single
openLCA database.

- Guidelines for conversion of processes using ecoinvent v.3.2 intermediate exchanges
to ecoinvent v.3.3.

- More user-friendly naming of activities.

- Access to the pack of LCIA methods as implemented by the ecoinvent Centre, in
order to reproduce their LCIA results.

- Possibility of using the openLCA LCIA methods pack thanks to the mapping of

elementary flows to the openLCA reference list.

If you have other questions not addressed by this report, need further clarifications on any of
the points commented, or have comments about the ecoinvent v.3.3 database in openlLCA,

please contact us.
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